
 
Bob Murphy Access Center (BMAC) 
Accessible Instructional Materials (AIM) Center 

 

1 
Accessible Instructional Materials (AIM) Center 
1250 Bellflower Blvd. AS-116 Long Beach, CA 90840 | 562.985.5401 | aimc@csulb.edu 

 

MICROSOFT WORD 
ACCESSIBILITY GUIDE 

Version 1.0 | Updated May 23, 2023 

  



 
Bob Murphy Access Center (BMAC) 
Accessible Instructional Materials (AIM) Center 

 

2 
Accessible Instructional Materials (AIM) Center 
1250 Bellflower Blvd. AS-116 Long Beach, CA 90840 | 562.985.5401 | aimc@csulb.edu 

 

TABLE OF CONTENTS 

Table of Contents 2 

Structure 4 
Styles 4 
Headings 7 
List 9 
Navigation Pane 10 
Structure Best Practices 11 

Formatting 12 
Spacing and Indentation 12 
Text Decoration 13 
Formatting Best Practices 19 

Fonts 20 
Accessible Fonts 20 
Font Size 20 

Links 22 
Links: Do’s and Don’ts 23 
Appearance of links 23 
How to insert a link in Word: 24 
Cross References 25 
Special Cases 27 

Alternative Text and Images 29 
How to add alternative text: 29 
Decorative Images 30 
Images of Text 31 
Complex Images 32 
Alternative Text Best Practices 33 

Table of Contents 35 



 
Bob Murphy Access Center (BMAC) 
Accessible Instructional Materials (AIM) Center 

 

3 
Accessible Instructional Materials (AIM) Center 
1250 Bellflower Blvd. AS-116 Long Beach, CA 90840 | 562.985.5401 | aimc@csulb.edu 

 

How to Add Table of Contents 35 

Tables 37 
Data Table 37 
Layout Table 37 
How to Create accessible tables: 38 
Tables Best Practices 39 

Color Contrast 39 
Color to Convey Information 40 
Color Contrast Best Practices 41 

Forms 42 
Placement of text labels 42 
Add Developer Tab 42 
Control Contents 44 
Legacy Tools 45 

Accessibility Checker 51 

Saving Word Docs into accessible PDFs 52 

Accessibility Laws 55 
Section 504 and the Americans with Disabilities Act of 1990: 55 
Section 508 55 
Accessible Technology Initiative (ATI) 55 
This isn’t just the law 56 

Recap and Further Recommendations: 56 

Resources 57 

 



 
Bob Murphy Access Center (BMAC) 
Accessible Instructional Materials (AIM) Center 

 

4 
Accessible Instructional Materials (AIM) Center 
1250 Bellflower Blvd. AS-116 Long Beach, CA 90840 | 562.985.5401 | aimc@csulb.edu 

 

STRUCTURE 

Structure is used to arrange document contents in a logical and meaningful manner. In 
Microsoft Word, there are ways to structure a document such as marking headings using Styles 
and grouping information together by using List. 

STYLES 

Styles are used to provide structure to the content of the document. Instead of changing the 
format of the text manually by enlarging the font size, making it bold, etc. If this is done, the 
document has no real structure. Once a Style is created, it can be applied globally throughout 
the document. For example, if you want to make the heading appear similarly across all pages, 
a Style can be applied and updated automatically.  

This section will outline to how use Styles in all common versions of Word. 

LOCATING STYLES 

1. Navigate to the Home ribbon. 
2. Locate the Styles pane. 

 

CREATE A NEW STYLE FROM SELECTION 

Users can add new headings or customizable styles to the Styles Pane. 

1. Highlight the desire text to add as a new style. 
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2. Using the dropdown icon in the Styles pane, expand the option menu. 
3. Select Create a Style from the dropdown list. 

 

MODIFYING STYLES 

You can make changes to a specific style to fit your needs. The modified style will be applied 
across all pages. 

1. Right click on a specific style option. 
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2. Select Modify to bring up the Modify Style window. 

 
3. In the Modify Style window, you can customize text formats and style. 

 

For more information, see Microsoft customize or create new style. 

BODY/NORMAL STYLE 

https://support.microsoft.com/en-us/office/customize-or-create-new-styles-d38d6e47-f6fc-48eb-a607-1eb120dec563
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Body/Normal styles are used for the rest of your document's content that are not headings and 
subheadings. Typically, normal style is applied to paragraphs of text. 

1. Highlight the desired area; in this case, we will highlight the rest of the document's 
content that is not assigned with a heading or subheading. 

2. In the Styles Pane Window select the Body Text or Normal style. 

HEADINGS 

Headings arrange contents in a hierarchical order. Heading structures need to follow an 
ascending order, H1 – H6. For example, the document's title should be heading level 1, and 
main sections should be level 2 and so forth. Proper heading structure allows assistive 
technology users to navigate to different sections of a document quickly without having to read 
the entire document. 

• Heading 1: Title of document 
• Heading 2: Main Section 
• Heading 3: Subsection 
• Heading 4 – 6: Can be used to further to separate different sections of the document. 

Note: Avoid using the Title Style in substitution for H1 as it can get converted into H4 in PDF in 
some cases. 

EXAMPLE OF HEADING STRUCTURE:  



 
Bob Murphy Access Center (BMAC) 
Accessible Instructional Materials (AIM) Center 

 

8 
Accessible Instructional Materials (AIM) Center 
1250 Bellflower Blvd. AS-116 Long Beach, CA 90840 | 562.985.5401 | aimc@csulb.edu 

 

 

HEADING STRUCTURE: DO’S AND DON’TS 

Do’s:  

• Apply Styles to document headings. 
• Follow hierarchical heading order (H1, H2, H3, and so on). 
• Make level headings appear differently so visual users can distinguish the headings for 

different sections.  
• Use simple and accessible font style for headings. 

Don’ts: 

• Use Font decoration such as enlargement or bold text to make content look like 
headings. 

• Skipped heading level such as using Heading 3 after Heading 1. 
• Use fancy font decoration. 
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APPLY HEADINGS AND SUBHEADINGS STYLES TO YOUR DOCUMENT 

1. Highlight the desired text that you would like to make into a heading. 
2. In the Styles Pane window select the Heading 1 style to create a primary heading. You 

can also select the pulldown menu right below the Styles Pane to access more options. 

 

LIST 

Lists are used to format information sequentially without the use of characters such as plus 
signs or asterisks. Always use Bullets or Numbering tools instead of other characters for listing 
information.  

BULLETED LIST VS NUMBERED LIST: 

• Use numbered list for items that specify order. 
 Examples: timeline or set of instructions  

• Use bulleted list where order is not important. 
 Example: grocery or recipe list. 

Note: Lists can be mixed such as using a bulleted list inside a numbered list, or vice versa.  
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HOW TO CREATE A LIST: 

1. Highlight the text you wish to format. 
2. Make sure you are in the Home tab. 
3. In the Paragraph panel, select the desired list type. 

 

NAVIGATION PANE 

The Navigation Pane is extremely important for ensuring your contents in the document is 
tagged properly. This pane also allows you to view different headings and subheadings in the 
document to ensure they are structured correctly. 

To access the Navigation Window: 

1. Select the “View” tab. 
2. Check the option for “Navigation Pane.” Alternatively, you can navigate to the Review 

tab. Select Check Accessibility menu dropdown and choose Navigation pane. 
3. The Navigation Pane should appear on the left side panel, listing the headings as an 

outline for the entire document. 

 

For more information, see Microsoft Support - Use the Navigation Pane. 

https://support.microsoft.com/en-us/office/use-the-navigation-pane-in-word-394787be-bca7-459b-894e-3f8511515e55
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STRUCTURE BEST PRACTICES 

• Use hierarchical heading levels providing correct H1, H2, H3, and so on. 
• Avoid skipping heading levels. 
• Use Styles to apply headings to the entire document.  
• Use Lists to organize contents in sequential order. 
• Use Navigation Pane to check for proper content structure in Word.  
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FORMATTING 

When designing documents, users often want to create empty spaces between paragraphs or 
text within the document. However, most users create extra space using the "tab" or "return" 
key will generate accessibility issues such that screen readers announce extra spaces as "blank." 
When multiple extra spaces are present, screen reader users may assume that they have 
reached the end of the document. 

Instead of using the “tab” or “return” key to format document space, use Paragraph Settings. 
This feature will allow you to create extra spaces between paragraphs, indentation, and line 
spacing while maintaining the appearance of the document. 

Tip: Enable the paragraph marks to show empty spaces and tabs in the document. 

 

SPACING AND INDENTATION 
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Spacing and indentation can be used in Styles when creating headings and body/normal text or 
it can be adjusted by using Paragraph Settings. 

HOW TO MODIFY SPACING AND INDENTATION: 

1. Select the desired text. 
2. In the Home tab, select Line and Paragraph Spacing. 
3. From the drop-down list, select Line Spacing Options... 
4. From the Paragraph pop-up window, adjust the Spacing and Indentation accordingly. 

 

For more information, see Microsoft Support: Adjust indents and spacing. 

TEXT DECORATION 

FONT FORMATTING 

Font format is use for visual presentation of the document. Once a style is added or modified, it 
can be applied globally to the entire document. You may have different styles for various levels 

https://support.microsoft.com/en-us/office/adjust-indents-and-spacing-36239d98-14c5-411e-a880-1ddf25d65cd6
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of heading, list structure, table or image caption, links, etc. Each style also comes with font size, 
color, spacing, indentation, etc.  

There are various options to explore in the Styles settings to customize your font style such as: 

• Font 
• Paragraph 
• Tabs 
• Border 
• Language 
• Frame 
• Numbering 
• Text Effects 

Explore the listed options to format the font styles that fit your needs. 
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HORIZONTAL LINE 

Horizontal line is commonly used to separate headings from body text. Horizontal lines can be 
added when modifying an existing style or creating a new style.  

To create a horizontal line: 

1. Right-click on a specific heading style from the Styles pane. 
2. Select Modify. 
3. From the Formatting pop-up window, select Format from the dropdown menu. 
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4. Choose Borders from the list. 

 
5. From the Borders and Shading window, select Custom option from the Borders tab. 
6. Select a line style from the list.  
7. Select color for the line style. 
8. Select the width of the line.  
9. In the Preview window, choose a diagram with an indication of the bottom horizontal 

line. 
10. To create line spacing between the horizontal line and the text, click on Options button. 
11. Adjust the Top and Bottom option within the Border and Shading Options window. 
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Note: you can apply top, left, and right border to create a box border effect to the paragraph if 
you wish to. 

PAGE BORDERS 

If you do not wish to apply border to paragraphs, instead, to apply border to a specific page or 
the entire document:  

1. Navigate to the Design tab. 
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2. Select Page Borders. 

 
3. From the Borders and Shading context window, use the Apply to: dropdown list and 

select an option.  
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FORMATTING BEST PRACTICES 

• Use Line and Paragraph Spacing settings to add empty spaces between paragraphs.  
• Avoid using “Return” key to create space between text. 
• Use Indentation settings to add spaces at the beginning of text line. 
• Avoid using “Tab” key to create indentation.  
• Use Borders settings to create a horizontal line and text decoration. 
• Use Page Borders functionality to create box border effects to specific page or entire 

document. 
• Avoid using Shapes to create borders as Word will recognize it as an image and will ask 

for alternative text. 
• Avoid manually entering underscores to create horizontal line effect.   
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FONTS 

Use simple and accessible fonts when formatting a Word document. Highly recommend using 
built-in fonts within Microsoft Word as it can be access across platforms and operating systems. 

ACCESSIBLE FONTS 

Use Sans-Serif fonts such as Arial, Calibri, Verdana, Tahoma, Helvetica, etc.  

 

Note: avoid using various types of fonts and overly decorative fonts within the same document 
as it can affect individuals with cognitive disability.  

For more information on accessible fonts, see Google's Introducing accessibility in typography. 

FONT SIZE 

Font size is extremely important for users with visual impairment. Ensure that the font size for 
Normal/Body Style is 12 points or larger. Font size can be set within the Styles setting when 
creating a style or modifying a style. 

https://fonts.google.com/knowledge/readability_and_accessibility/introducing_accessibility_in_typography
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LINKS 

Link text should provide a clear description of the link destination, rather than only providing 
the URL. There are many options when it comes to including a hyperlink in your document. You 
can insert and attach a hyperlink with an email, an external document, and webpage. 

Note: Avoid using “Place in This Document” when linking to a specific section within the 
document. See Cross References for more information. 

 

Links must have a descriptive link text that describes the intent or purpose of the link. For 
example, avoid using “Click here” or “Read more.” Assistive technology users often navigate 
through links to skim through the document, when they come across links descriptions like 
“Click here,” they will not understand the purpose or the link’s destination. Instead, include the 
webpage or document title as the link description. In addition, long URL addresses can be 
cumbersome for assistive technology users to listen to. 
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LINKS: DO’S AND DON’TS 

Do’s:  

• Use descriptive link text that describes the intention of the link. 
• Good examples: 

 CSULB Accessible Instructional Materials (AIM) Center 
 W3C Accessibility Standards Overview 

Don’ts: 

• Use ambiguous link text or long URL addresses. 
• Bad examples: 

 Click here or read more 
 https://www.w3.org/WAI/standards-guidelines/ 

APPEARANCE OF LINKS 

Links must be visually different from regular text. Links are often identified with underline and 
color. Ensure that color should not be the only method to identify links and should be 
accompanied by an underline or italics. Both these methods will help increase the document’s 
readability by allowing the reader to identify links visually. 

 

Figure 1 In the example above, there are no visual indicators for links. Visual readers will not 
know that links are present within the paragraph of text. 

https://www.csulb.edu/student-affairs/accessible-instructional-materials-center
https://www.w3.org/WAI/standards-guidelines/
http://www.google.com/
https://www.w3.org/WAI/standards-guidelines/
https://www.w3.org/WAI/standards-guidelines/


 
Bob Murphy Access Center (BMAC) 
Accessible Instructional Materials (AIM) Center 

 

24 
Accessible Instructional Materials (AIM) Center 
1250 Bellflower Blvd. AS-116 Long Beach, CA 90840 | 562.985.5401 | aimc@csulb.edu 

 

 

Figure 2 In the example above, the links appear different from the surrounding text. The link 
text contains a combination of color and underline. The combination of these indicators will 
make the links apparent to visual readers. 

HOW TO INSERT A LINK IN WORD: 

1. Highlight the desired text 
2. In the Insert tab, select Link. Alternatively, the user can right click and select Link from 

the context menu. 

 

3. In the Insert Hyperlink pop-up window, enter in the Text to display. 
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4. In the Address field, ensure that the complete URL is included, and the text corresponds 
with the correct URL address. Click Ok to insert link. 

 

CROSS REFERENCES 

Cross references are links within the document that are used to refer to another place in the 
document. Cross references are inserted as fields, which ensure contents get updated 
whenever there is a change. This is not to be confused with the Table of Contents which lists all 
sections of the document.  
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HOW TO ADD CROSS-REFERENCE  

1. Navigate to the Reference tab. 
2. Select Cross-reference. 
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3. Choose the heading that you want to reference to. 

 
4. Select Insert to add cross-reference link. 
5. Format the link style so it can be easily recognized. 

SPECIAL CASES 

LINKING PHONE NUMBERS AND EMAIL ADDRESSES: 

It is highly recommended to use both descriptive link text followed by actual email or phone 
number, allowing users to save this information for future reference.  

Example of email address: AIM Center (aimc@csulb.edu) 

Example of phone number: BMAC Main Office (562-985-5401) 

LINKS ON PRINT DOCUMENTS: 

If the document is available digitally and as a physical copy, it is preferred to include a 
descriptive link text followed by the full URL address of the link. 

Example: CSULB College of Business [https://www.csulb.edu/college-of-business] 

LINKS FOR FILE DOCUMENT TO DOWNLOAD: 

If the link is direct to open or download a document like PDF, include the title as the link text 
followed by the file type. 

mailto:aimc@csulb.edu
tel:562-985-5401
https://www.csulb.edu/college-of-business
https://www.csulb.edu/college-of-business
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Example: 2022-2023 CSULB Academic Calendar (PDF)  

https://www.csulb.edu/sites/default/files/document/academic_calendar_22-23_text.pdf
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ALTERNATIVE TEXT AND IMAGES 

Alternative text also known as “alt text” is a brief 8 to 120-character description describing the 
elements of the image or what the image is conveying. Assistive technology relies on 
alternative text to describe the image to the reader. In situations where the image is not 
available to the reader, perhaps because they have turned off images in their web browser or 
are using a screen reader due to a visual impairment, the alternative text ensures that no 
information or functionality is lost. The content creator is the best person to determine the 
alternative text for an image. Context is important when determining the alternative text; it will 
let you know if the alternative text is too descriptive or not descriptive enough. 

Note: Images must be placed “In Line with Text” to ensure logical reading order. 

HOW TO ADD ALTERNATIVE TEXT: 

1. Select the desired object. 
2. Navigate to the Picture Format tab and select Alt Text. Alternatively, you can right click 

on the image to bring up the Context Menu and select Edit Alt Text. 
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3. Enter the alternative text for the image in the entry field. 

 

DECORATIVE IMAGES 

Decorative images are images that present no important content to the context of your 
document. They are purely aesthetic. If you have images in your document that serve visual 
purposes and do not provide any information (clip art, banners, background images, etc.), mark 
them as decorative. 

HOW TO MARK IMAGES AS DECORATIVE: 

1. Select the desired object. 
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2. Navigate to the Picture Format tab and select Alt Text. Alternatively, you can right click 
on the image to bring up the Context Menu and select Edit Alt Text. 

 
3. Select the “Mark as decorative” checkbox in the Alt Text pane that opens on the right-

hand side. 

 

IMAGES OF TEXT 

Images of text display text as an image. It is highly recommended using actual text rather than 
image of text. Actual text is much more flexible in comparison to images of text that it can be 
resized without losing clarity and enable users to customize things like color and contrast based 
on user’s preferences. Image of text is best use as logo when the visual presentation is 
essential. 
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Alternative text for images of text should reflect the text within the image. If the image contains 
more than 120 characters, consider including the text elsewhere within the document.  

 

COMPLEX IMAGES 

Complex images are images that convey substantial information and require over a 120- 
character description, such as graphs and charts. Figure captions can be used in addition to alt 
text and are placed above or below the image. Contrary to alt text, there is no character limit 
for figure captions.  

Note: an image that has a figure caption also needs to include alternative text since alternative 
text is required for all images. Ensure that alternative text does not repeat exactly what is 
already stated in the figure caption. 

Tip: Alternative text for complex images can briefly describe the image and reference to read 
more in the figure caption. If the description of the figure caption is too long, provide an 
external link to the source for reference. 

HOW TO ADD FIGURE CAPTIONS: 

1. Select the desired object. 
2. Right click to bring up the context menu and select Insert Caption. 
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3. In the Caption pop-up window. Enter the description for figure caption. 

 

ALTERNATIVE TEXT BEST PRACTICES 

• Avoid using phrases such as “image of” or “photo of” for alt text because screen reader 
will repeat this information. 

• Avoid using images of text due to low image quality when resized. 
• The “Alt Text” tool does not have spell check, please ensure that the alt text is spelled 

correctly. 
• Avoid using the “generate a description for me” feature because the alternative text 

may not always be accurate. 
• Decorative images that do not convey any meaning do not require alternative text and 

should be mark as decorative. 
• If the alternative text is too long, consider using figure caption to provide descriptive 

information for complex images. 
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• If the type of image is important such as water painting or pencil drawing, include it in 
the alt text. 

• Avoid using screenshots or images of lists, tables, or similar contents as alt text can be 
very long and content structure is not available for screen reader users.  
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TABLE OF CONTENTS 

Create a table of contents for long documents to help readers navigate through the document. 
Much like headings, the table of contents gives users an overview of the document and allows 
them to navigate to specific sections. 

Tip: Structure the headings in your document first; headings are used to generate the table of 
contents 

HOW TO ADD TABLE OF CONTENTS 

1. Navigate to the “References” tab. 
2. Select the “Table of Contents” table. 
3. Choose a template from the dropdown menu or customize your own table of contents. 

 
If you choose Custom Table of Contents..., you can modify the heading level that are included 
in the Table of Contents.  
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To eliminate Heading 1 from appearing in the table of contents, select Options… and delete the 
number 1 from the Available styles.  
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TABLES 

DATA TABLE 

Data tables are used to present relationships between the data cells in a grid or tabular format. 
Data tables must have column/rows headers to be accessible. 

 

LAYOUT TABLE 

Layout tables do not present any associations between the cells and are not format with 
columns headers, they are typically used to organize visual information. Avoid using layout 
tables as they are inaccessible and do not provide meaningful order of the content. 

 

Figure 3 Visual users will read the table as “Push The Button To Activate”, however, if not 
linearized properly, the screen reader will read it as “Push Activate The To Button.” In many 
cases, the linearized reading order and visual reading order may not be the same, thus, making 
it difficult for screen reader users to understand the contents within layout table. 
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To learn more about the differences between data and layout tables, see WebAIM Creating 
Accessible Tables. 

HOW TO CREATE ACCESSIBLE TABLES: 

There is only one proper way to create a table in Microsoft Word. Follow these simple steps to 
create an accessible table: 

1. Navigate to the Insert tab. 
2. Select the Table functionality. 
3. Choose the number of rows and columns for your table. 

 
4. Ensure that the Header Row (column headers) check box is checked. 

 
5. Highlight the first row of the table. 

https://webaim.org/techniques/tables/
https://webaim.org/techniques/tables/
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6. Navigate to the Layout tab, select Repeat Header Rows.  

 

Note: Repeat Header Rows enable the column headers to repeat across multiple pages in case 
you are dealing an awfully long table. If you change column header on the first page, the 
headers change on other pages. 

TABLES BEST PRACTICES 

• Have clear and understandable column or row headers (week, due date, grades, 
topic, etc.) 

• Use Repeat Header Rows for tables that span more than one page. 
• Use data table to present tabular information. 
• Use a simple table with single-level header. 
• Avoid merging cells. 
• Avoid merging multiple tables together. 
• Avoid layout tables. 
• Avoid low contrast cell colors. 
• If a table has an empty cell, indicate that there is no data such as N/A or Not Applicable. 
• Ensure that the table borders are visible. 
• Avoid adding table title (known as a caption) in a table cell. Caption should be placed 

before or after the table. 
• Avoid using vertical text as it is can be difficult to read. 
• Avoid breaking contents of the same row to another page as it can be difficult to 

navigate for contents. 
To read more about accessible tables, see CSUN Web Accessibility Criteria: Tables. 

COLOR CONTRAST 

https://www.csun.edu/universal-design-center/web-accessibility-criteria-tables
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Color is often used to make documents visually appealing and attract the reader’s attention. 
Color contrast is related to the relationship between colors and their perceived visibility. In the 
context of accessibility, it is advised that the content creator use high contrast color 
combinations to avoid any potential issues with reading/visibility. 

Color contrast should meet the minimum Level AA standard and maintain at least a color 
contrast ratio of 4.5:1. There are different accessibility software and programs, such as the 
WebAIM Contrast Checker, to check for color accessibility. 

For example, black print on white paper or white print on black paper are high contrast color 
combinations. Students who are color blind can potentially have issues with low contrast color 
combinations.  

COLOR TO CONVEY INFORMATION 

Color should not be the only method to convey information. Readers that cannot perceive color 
will be unable to understand the context or representation of the color. Instead, in combination 
with color, use different objects such as shapes to differentiate between content. 

EXAMPLE OF COLOR INFORMATION:  

 

Figure 4 The image on the left shows the color version to demonstrate how readers perceive 
color will view the image. They will be able to find the number of orange triangles. The image 
on the right shows how people cannot perceive color will view the image. They will be unable 
to find the number of orange triangle as they all appear the same. 

https://webaim.org/resources/contrastchecker/
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Figure 5 This image asks, "how many triangles are there?" This question does not rely on 
sensory characteristics such as color to understand its context. 

COLOR CONTRAST BEST PRACTICES 

• Avoid using light orange, red, and green against a white background in your template 
and text. 

• Use texture or label in graphs, instead of color, to highlight points of interest. 
• Circle to highlight information, rather than relying on color. 
• Keep the overall contrast in your presentation high. In other words, avoid using 

light colored text against light backgrounds, and dark colored text against dark 
backgrounds. 

• WebAIM Contrast Checker and Colour Contrast Analyser are free software that 
checks contrast accessibility for background and foreground colors using WCAG 2.1 
standards. 

• Color Safe develops accessible color palettes.  

https://webaim.org/resources/contrastchecker/
https://developer.paciellogroup.com/resources/contrastanalyser/
http://colorsafe.co/
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FORMS 

Prior to creating a form, users should outline what kind of questions will be asked and the type 
of answers that are expected whether the users are going to interact with check boxes, text 
field, radio buttons, etc. Questions and labels for any kind of form field should be simple and 
understandable. 

Depending on the needs of the content creator, forms can either be completed in Microsoft 
Word or Adobe Acrobat Pro for PDF. There are two different form functionalities in Word that 
you can generate: 

• Content Controls: use to generate and complete the form in Microsoft Word and can be 
post online as a completed PDF.  

• Legacy Form: use to complete the form in Adobe Acrobat Pro (PDF) and can be post 
online as a downloadable template. 

Note: In order to convert fillable form fields from Microsoft Word to PDF, you must have 
CommonLook Office installed on your machine. Using “Save As PDF” or “Adobe PDFMaker” will 
flatten out the form fields, as a result, the document will be saved and show as regular text 
without the associated fillable form fields. 

PLACEMENT OF TEXT LABELS 

The placement of label is not required by standard but as recommended: 

• Labels are placed to the left of the text field and drop downs. 
• Labels are placed to the right of check boxes.  

ADD DEVELOPER TAB 

Developer tab allows users to add fillable form fields within Microsoft Word documents. 

If you do not have the Developer ribbon already added in Microsoft Word:  
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1. Navigate to File menu. 

 
2. Select Options. 

 
3. Select Customize Ribbon. 
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4. Under the Main Tabs for Customize the Ribbon, check box the Developer option. 

 

CONTROL CONTENTS 

As mentioned previously, Controls Contents are used with the purpose of creating form fields 
for users to fill out in Microsoft Word only. 

Note: Restrict Editing is highly recommended to use when a fillable form in Microsoft Word is 
created by limiting users from editing and formatting specific contents of the document. See 
Microsoft Support: protect document using Restrict Editing for more information. 

LOCATING CONTROL CONTENTS IN MICROSOFT WORD 

https://support.microsoft.com/en-au/office/allow-changes-to-parts-of-a-protected-document-187ed01c-8795-43e1-9fd0-c9fca419dadf#:%7E:text=On%20the%20Review%20tab%2C%20in%20the%20Protect%20group%2C%20click%20Protect,No%20changes%20(Read%20only).
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1. Navigate to the Developer tab.  
2. In the Controls pane, select to add a control content form field. 

  

To create fillable forms in Microsoft Word, See Microsoft Support: Create forms that users 

complete or print in Word.  

LEGACY TOOLS 

As mentioned previously, Legacy Forms make fillable form fields to be completed in Adobe 
Acrobat Pro (PDF). To convert fillable form fields from Microsoft Word to PDF, content creators 
must have CommonLook Office installed on their local machine. If you do not have a license for 
CommonLook Office, fillable form fields can be generated within Adobe Acrobat Pro (PDF).  

Learn how to make fillable form fields in Acrobat, see UA Technology PDF Accessibility with 
Adobe Acrobat Pro DC Forms Training video.  

LOCATING LEGACY FORMS IN MICROSOFT WORD 

1. Navigate to the Developer tab. 
2. In the Controls pane, select to expand the Legacy Tools to add Legacy Forms. 

https://support.microsoft.com/en-us/office/create-forms-that-users-complete-or-print-in-word-040c5cc1-e309-445b-94ac-542f732c8c8b
https://support.microsoft.com/en-us/office/create-forms-that-users-complete-or-print-in-word-040c5cc1-e309-445b-94ac-542f732c8c8b
https://www.youtube.com/watch?v=mXfDNQuXYAo
https://www.youtube.com/watch?v=mXfDNQuXYAo
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Use Legacy Forms to generate form fields in Word such as text fields, check boxes, and 
dropdowns.   

Note: ActiveX Controls forms are way more complex to use and require the use of JavaScript, 
which is more technical and can produce accessibility issues.  

FIELD PROPERTIES 

To open the field properties options:  

1. Select a form field in the document. 
2. Navigate to the Developer Tab. 
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3. Select Properties. 

 

TEXT FIELD PROPERTIES 

In the Text Form Field Option, there are various options to customize such as: 

• Type: choose a particular text format. If you want to restrict user inputs to only numbers 
or characters only, select a corresponding type.  

• Default text: provide the text before the user fills out the form. This is not 
recommended as users will mistakenly think that the field is already filled out and 
possibly skip the question. Do not use Default text as label.  

• Maximum length: the maximum number of characters that can be inputted.  
• Text format: specific format that will be taken as inputs.  
• Add Help Text to include tooltips for the input field. 

CHECK BOX PROPERTIES 
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Select “Auto” for Check box size and “Not checked” for Default value. 

 

When adding help text (tooltips), indicate the question/label before listing out the choices. 
Include how many choices of checkboxes there are related to a particular question. You also 
don’t have to repeat the question being asked for the remaining checkboxes if the 1st checkbox 
tooltip is already provided. 

Example tooltips for checkboxes:  

1st checkbox: “Choose the hobbies you enjoy from the following. 1 of 6: Working in the yard.” 

2nd checkbox: “2 of 6: Exercise.”  

The rest of the tooltips can be auto generated using CommonLook Office (if applicable). 
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DROP-DOWN PROPERTIES 

Add Drop-down item to the Items in drop-down list. 

Provide the question and indicate that this is a dropdown with a list of options for tooltip. 

 

Example tooltips for drop-down list: 

“Do you have any pets? Choose from the list of options.” 
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HELP TEXT/ TOOLTIPS 

Tooltips allow screen readers to convey information that is being asked in the form for users to 
fill out the appropriate response.  

Note: the screen reader will only read the Tooltips and not the label text in Focus mode, 
therefore, be descriptive as possible when providing tooltips. For example, if a field is required, 
indicate that it is required.  
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ACCESSIBILITY CHECKER 

Just as the spelling checker tells you about spelling errors, Accessibility Checker in Word and 
PowerPoint tells you about accessibility issues in your document file, so you can fix these issues 
to ensure someone with a disability can read and access your content. 

Please note that the Accessibility Checker does not ensure 100% accessibility. However, it is a 
great tool for reviewing your document for errors you could have missed. 

Follow these steps to utilize the Accessibility Checker: 

1. Navigate to the Review tab.  
2. Select Check Accessibility. Alternatively, you can locate the Accessibility Checker on the 

bottom left of the document next to the word count.  

 
3. The Accessibility Inspection pane will pull up on the right-hand side. 
4. Follow the checker and make the proposed changes to ensure accessibility of your 

document. 
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SAVING WORD DOCS INTO ACCESSIBLE PDFS 

The most accessible conversion from Microsoft Word into PDF is using the PDFMaker plugin or 
Save as Adobe (PDF). To ensure that Microsoft Word is converting into accessible PDF: 

1. Navigate to the Acrobat Tab.  
2. Select Preferences. 
3. From the Acrobat PDFMaker menu pop-up, check box “Enable Accessibility and Reflow 

with tagged Adobe PDF.”  
4. Hit Ok to save preference settings.  
5. After you have set the preferences, select Create PDF in the same tab, and save the file 

to your local computer. 
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Note: Avoid saving documents using Print to PDF as the it removes the tag structure, making 
the document inaccessible. 

If you do not have Acrobat Plugin in Microsoft Word, save the document as PDF on your local 
computer by: 

1. Navigate to the File menu. 
2. Select Save As. 
3. Save the document as PDF. 
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4. Select the Options… menu. 

 
5. In the Options window, ensure that Document structure tags for accessibility is checked 

and press OK to save the document. 
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ACCESSIBILITY LAWS 

SECTION 504 AND THE AMERICANS WITH DISABILITIES 
ACT OF 1990: 

Section 504 of the Rehabilitation Act of 1973 created and extended civil rights to people with 
disabilities. Section 504 has provided opportunities for children and adults with disabilities in 
education, employment, and various other settings. It allows for reasonable accommodation 
such as special study areas and assistance as necessary for each student in Federal agencies. 
Section 504 laws were then extended through the Americans with Disabilities Act of 1990 and 
the ADA Amendments Act of 2008 (ADAAA) which broadened the definition of “disability” to 
cover both individuals with physical and mental disabilities. 

SECTION 508 

This amendment to Section 504 and the Americans with Disabilities Act of 1990 was enacted in 
1998 to eliminate barriers in information technology, to make available new opportunities for 
people with disabilities, and to encourage development of technologies that will help achieve 
these goals. The law applies to all Federal agencies when they develop, procure, maintain, or 
use electronic and information technology. Under Section 508, agencies must give employees 
and members of the public with disabilities access to information comparable to that available 
to others. California Government Code Section 11135-11139.8 requires all agencies that receive 
state money to comply with Section 508, and Executive Order Number 926 requires all CSU 
campuses to comply with Section 508. 

ACCESSIBLE TECHNOLOGY INITIATIVE (ATI) 

Effective on January 1st, 2005, Chancellor Charles B. Reed enacted CSU Executive Order 926, 
“The CSU Board of Trustees Policy on Disability Support and 

Accommodations.” The intent of the Accessible Technology Initiative is to make information 
technology resources and services accessible to all students, employees, and guests regardless 
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of disability. CSULB is committed to this initiative by maintaining consistent accessibility and 
promoting assistive technology to students, administrators, and faculty campus wide. 

THIS ISN’T JUST THE LAW 

This is your chance to assist this longstanding and respected institution of learning to better 
serve the public with only the greatest intentions of educational and moral outcomes for the 
success of others. 

RECAP AND FURTHER RECOMMENDATIONS: 

• Assign Styles to text to build document structure. 

• Use heading, subheading, and body styles to create hierarchy in your document. 

• Make sure all headings are in correct order (Heading 1, Heading 2, Heading 3, etc.) 

• Always use the “Bullets” or “Numbering” tools to format lists. 

• Use simple language and font style. 

• Use simple table structures with proper table headers. 

• Create proper table of contents for long documents. 

• Avoid using low contrast colors (pale or gray colors against white paper). 

• Assign descriptive alternative text to your images. If an image is decorative, mark it as 

decorative. 

• Label hyperlinks with simple, but accurate descriptions. 

• Use Content Controls to generate form fields to be completed in Microsoft Word. 

• Use Legacy Forms to generate form fields to be completed in PDF. 

• Ensure all tooltips and labels are included for every form fields. 

• Avoid using repeated blank [spacebar or return] characters (they will read as “blank” 

repeatedly by screen readers). Instead, use spacing and indentation settings to create 

blank spaces. 
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• Avoid image watermarks (they may not be understood by people with visual or 

cognitive disabilities). 

• Run the accessibility checker to make sure you have made all appropriate changes 

to ensure accessibility is met. 

• Avoid Print to PDF to convert Word document to PDF, instead Save as PDF with 

accessibility option checked. 

RESOURCES 

• An Introduction to Accessibility – Digital.gov 

• Tutorials | Web Accessibility Initiative (WAI) | W3C 

• Dos and Don’ts on Designing for Accessibility 

• Harvard University: Designing for Readability 

• Microsoft: Make Your Word Documents Accessible to People with Disabilities 

• WebAim: Alternative Text 

• WebAim: Creating Accessible Documents 

• WebAim: Links and Hypertext 

• Microsoft Support: Create forms that users complete or print in Word  

• WebAIM Converting Document to PDF 

• CSULB: ATI Document Accessibility 

• AIM Center: Accessibility Resources 

• AIM Center Microsoft Word Accessibility Training Videos 

• UA Technology Accessible Word Document Training Video 

• Section 508 Create Accessible Documents Trainings  

• Americans with Disabilities Act Government Homepage 

• Section 504 Government Homepage 

• Section 508 Government Homepage 

https://digital.gov/resources/introduction-accessibility/
https://www.w3.org/WAI/tutorials/
https://accessibility.blog.gov.uk/2016/09/02/dos-and-donts-on-designing-for-accessibility/
https://accessibility.huit.harvard.edu/design-readability
https://support.microsoft.com/en-ie/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d
https://webaim.org/techniques/alttext/
https://webaim.org/techniques/word/
https://webaim.org/techniques/hypertext/
https://support.microsoft.com/en-us/office/create-forms-that-users-complete-or-print-in-word-040c5cc1-e309-445b-94ac-542f732c8c8b
https://webaim.org/techniques/acrobat/converting#save
https://www.csulb.edu/information-technology/accessible-technology/document-accessibility
https://www.csulb.edu/student-affairs/accessible-instructional-materials-center/accessibility-resources
https://www.youtube.com/playlist?list=PLELSqs1L9DEDdfJi67k5CNbnFan1WVxAb
https://www.youtube.com/watch?v=lWRaw7krQug
https://www.section508.gov/create/documents/
https://www.ada.gov/
https://www2.ed.gov/about/offices/list/ocr/504faq.html
https://www.section508.gov/
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• EO-926 / Accessible Technology Initiative Statement 

 

 

 

 

 

 

https://www.calstate.edu/eo/EO-926.pdf

	Microsoft Word Accessibility Guide
	Table of Contents
	Structure
	Styles
	Locating Styles
	Create a new Style from selection
	Modifying Styles
	Body/Normal Style

	Headings
	Example of heading structure:
	Heading Structure: Do’s and Don’ts
	apply headings and subheadings styles to your document

	List
	Bulleted list vs Numbered list:
	How to create a list:

	Navigation Pane
	Structure Best Practices

	Formatting
	Spacing and Indentation
	How to modify spacing and indentation:

	Text Decoration
	Font Formatting
	Horizontal Line
	Page Borders

	Formatting Best Practices

	Fonts
	Accessible Fonts
	Font Size

	Links
	Links: Do’s and Don’ts
	Appearance of links
	How to insert a link in Word:
	Cross References
	How to add cross-reference

	Special Cases
	Linking phone numbers and email addresses:
	Links on print documents:
	Links for file document to download:


	Alternative Text and Images
	How to add alternative text:
	Decorative Images
	How to mark images as decorative:

	Images of Text
	Complex Images
	How to add figure captions:

	Alternative Text Best Practices

	Table of Contents
	How to Add Table of Contents

	Tables
	Data Table
	Layout Table
	How to Create accessible tables:
	Tables Best Practices

	Color Contrast
	Color to Convey Information
	Example of color information:

	Color Contrast Best Practices

	Forms
	Placement of text labels
	Add Developer Tab
	Control Contents
	Locating Control Contents in Microsoft Word

	Legacy Tools
	Locating Legacy Forms in Microsoft Word
	Field Properties
	Text Field Properties
	Check Box Properties
	Drop-Down Properties
	Help Text/ Tooltips


	Accessibility Checker
	Saving Word Docs into accessible PDFs
	Accessibility Laws
	Section 504 and the Americans with Disabilities Act of 1990:
	Section 508
	Accessible Technology Initiative (ATI)
	This isn’t just the law

	Recap and Further Recommendations:
	Resources


